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1 Introduction

1 Introduction

Discover the musical talents sleeping in your Macintosh, and experience a whole new world of
music with the Sound-Trecker V2.0! With the Sound-Trecker, you can listen to the huge library of
songs stored in the platform-independent .MOD' format, in a brilliant quality with a crystal clear

sound!

The Sound-Trecker has a intuitive user interface, that you can use immediately, if you have ever
used a CD player before. Compile your favorite songs to whole programs of music, which can
then be played back in sequentially or randomly. Use the mixing console to mix the sound
channels individually. Place each single channel at arbitrary positions in the stereo triangle. Or at
the “surround” position, in which the sound will appear to come from everywhere around you,
especially, if your HiFi set contains one of the famous surround processors (due to the surround

capabilities, someone called the Sound-Trecker “Surround-Trecker”).

If you are interested in the principles of digital audio processing, you can experiment with several
signal processing parameters. Find out, how the quality of sound is affected, e.g., by the sampling
rate or the type of sound filtering. See the sound on the display as an oscillogram, or as a realtime
spectrum (either as a line spectrum, as you will find on a professional spectrum analyzer, or as a

band spectrum, like that on your equalizer).

The Sound-Trecker fully utilizes the multitasking capabilities of System 7. Music will continue
even if you switch the Sound-Trecker in the background, so you can work with your Macintosh
while listening to "MOD' music. Now it will be even more fun to use your favorite computer!
Playing back music in the background requires, depending on the sound quality and your Mac's
power, between 10% (Mac Quadra, cache on) and 76% (Mac LC in best quality) of the CPU time.

The Sound-Trecker runs on any Macintosh with a M68020 processor or higher, or on the
PowerBook, the Macintosh Portable, and on the new Macintosh “av” and “PowerPC” series. At

least System 6.0.7 is required, System 7 is preferred.
Balloon-Help

Sound-Trecker V2.0 uses “Balloon Help” of System 7. Switch Balloon Help on or off with the
help menu @—Symbol). To get help about an object, switch Balloon Help on and simply move
the mouse pointer over the object. A help balloon will appear and show information about the

object.

The Sound-Trecker V2.0: User Manual (12/16/93) 2 Copyright © 1991-1993 by Frank Seide



1 Introduction

".MOD’ files

The "MOD' file format is a compact, platform independent file format for storing songs. This
format was introduced by the program “SoundTracker” written for computers of the Commodore-
Amiga family. In addition to several Amiga versions, implementations of "MOD' file players are
available for the Atari-ST/TT family, PC/AT-compatibles, Acorn Archimedes, Apple Ilgs, and
even for UNIX workstations, e.g. SUN. The Sound-Trecker makes the whole '"MOD'" music

library accessible to Macintosh users.

With the "MOD' format, many minutes of music can be stored in an extremely space saving way,
usually requiring less than 150K. For example, the famous “Axel F.”-MOD takes up only 114K of
disk space at a total playing time of over 10 minutes. A normal Macintosh sound file of 114K
could store only about 5 seconds of sound (22 kHz, 8 bit, mono, no compression)! The gain is
obtained by storing the notes of a song rather than the sampled song directly. To play such a song,
the Sound-Trecker simulates a synthesizer. The sound synthesis is based on digitized instruments

and thus has a very high quality.

The music files are often called “Modules” or "MOD' files; we will call them simply “songs”.
During the last years, many excellent .MOD' songs have been created. Usually, they are in the

public domain and available through bulletin boards, for example.

When the Sound-Trecker V1.0 was published in 1992, it used to be difficult to get "MOD' files on
Macintosh formatted disks, because at that time, the '."MOD' format was completely unknown in
the Macintosh world. The files had to be transferred to the Mac, i.e. via telephone with a MODEM
from a non-Macintosh bulletin board. Now, this has changed thoroughly: hundreds of .MOD' files
are available on Macintosh disks, on the famous public-domain collections and CDs, and through

many Macintosh user groups.

The Sound-Trecker V2.0 also introduces the Amiga Oktalyzer format to the Macintosh world,
which supports up to 8 voices, and an extended "MOD' format permitting up to 32 polyphonic

voices.
Structure of this manual

In the following chapters, basic operation (chapter 2) and the functions of the extended view
(chapter 3) are covered. Chapter 4 describes how to compile programs of music from songs. All
remaining functions are explained in chapter 5. Appendix A contains hints, where to get ."MOD'
files for your Macintosh. Appendix B describes some technical detail and the basics of the "MOD'

file format.
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Those who are interested in using the Sound-Trecker's music capabilities from within their own
programs and presentations, please refer to “The Sound-Trecker V2.0: Programmer's Guide” and
to “The Sound-Trecker V2.0: 'XFCN' Manual”.

Shareware

“Sound-Trecker V2.0” is a shareware product. This means, you may copy it freely and try it out
thoroughly. As soon as you decide to use the program, you are requested to send a modest amount

of money.

You will find the exact conditions for using the Sound-Trecker in the “License Agreement” file,
that should have accompanied your copy of the Sound-Trecker. You might copy the Sound-
Trecker application program freely to anyone, but only in its entire, including this user manual and
the license agreement file. This is to make sure anyone gets the chance to fully exploit the Sound-
Trecker's capabilities. If the license agreement file is missing, your are not permitted to use the

program (sorry!).

The programmer's manual, the sample source codes, and the code libraries, that you need for
playing back "MOD' files from within your own programs, should be copied along with the
Sound-Trecker. If you did not get those files, I will send them to you, if you send me a disk, a self-

addressed envelope, and the money for the postage.

If you have any questions, contact me via mail (please don't forget the return postage) or via e-

mail at seidee@pfa.philips.de.
Compatibility

Sound-Trecker should be compatible with all software written according to the rules given in
“Inside Macintosh”. Problems may arise, however, when it is used together with older software
which uses the “Sound Driver” instead of the new “Sound Manager”. As soon as a program uses
the old Sound Driver, the Sound Manager switches into compatibility mode and stops all sound
output generated through Sound Manager calls, including Sound-Trecker’s. When you quit the old
program, the Sound Manager immediately restarts sound. lL.e., old versions of the “SoundMaster”

may cause the Finder to issue a Sound Driver call, and you usually can’t quit the Finder!

One special problem arises in conjunction with the another '"MOD' player, “Player Pro” by
Antoine Rosset and Mike Venturi. In some versions, e.g. 4.10, each "MOD' file is converted to a
“Player Pro” file without warning whenever you open it. Such a file can be recognized from the
changed icon. Although the Sound-Trecker can still open such a file, double clicking the icon will
now automatically start “Player Pro”. The modification can be undone only with special tools like

“ResEdit”. So, only open copies of ."MOD' files with “Player Pro”.
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2 Basic Operation

In this chapter, basic operation of the Sound-Trecker is described, e.g., how to load and play

songs, and how to use the control buttons.

2.1 Starting the Sound-Trecker

Sound-Trecker can be started by double clicking on the program icon (), just like any other

Macintosh application. The symbol is a tractor (German “Trecker”) with notes coming out of its
exhaust pipe. Alternatively, the Sound-Trecker may be started by selecting one or more sound
tracks in the Finder, and opening them by double clicking. Under System 7, .MOD' files may be
dragged and dropped onto the Sound-Trecker icon. Sound-Trecker may also be started by opening

a song list (see chapter 4).

2.2 Screen Display

The Sound-Trecker EFIE
Song List: 82 Songs

Happy Hippos.mod
Hopeful Towns.mod [
Jumping Jack'son.mf._.
+ Space Debris.mod |
The Sad History.modj
virgin
After Morning.mod
Amegas.MO0D
Berlin.mod <

(<] Remaining Time -03:32
[]Repeat [ Shuffle
(< Stereo []Muting

W | | | P

[»]

Figure 2.1: collapsed view of the Sound-Trecker

Figure 2.1 shows the “collapsed” view of the Sound-Trecker. Clicking the “zoom box” in the
upper right corner will activate the extended view. Sound-Trecker usually starts up with the

extended view; in this chapter, however, only the functions of the collapsed view are discussed.
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Above the playing time display you find the song list. In the song list, you can compile your own
individual selection of songs (as shown in chapter 4). The song being played is marked by a
proceeding 4 symbol, in the above example the song “Space Debris”. The slider at the bottom

shows the current position within the song.

At the bottom, there are four large and two small buttons to control the playing back of songs in a

way similar to your CD player.

2.3 Playing a song

To play a song, you must first put it into the song list. To do this, select the menu command
“Open...” in the “File” menu (shortcut: 3&-0, i.e., hold down the 3 key and press 0). After
choosing “Open...”, you will see a standard file dialog box, in which you should, as usual, choose

the track to play.

When you open a song, it will be appended to the song list. If nothing is being played, the new
song will be loaded and started automatically. To start a song that is already in the song list, just

double click on it.

By the way, in addition to actual "MOD' files, the file dialog shows ordinary text files, because
after downloading a "MOD' file from a bulletin board or copying it from a PC diskette, the
Macintosh often regards those files formally as text files, although they are in fact "MOD' files
(see also appendix A). When such a file is opened, the Sound-Trecker program asks automatically,
whether the file type should be set correctly. Normally you will accept this. If you open a real text

file by mistake, the Sound-Trecker will notice this and reject the file as being no "MOD' file.

2.4 The Control Buttons

The control buttons at the bottom of the window are behaving just as the respective keys on your

CD player. Their functions are:

Play / Pause: to play a song, select it in the song list and click here (if the song
| list is empty, the “Open...” command will be executed automatically). If a
sound is currently being played, it will be paused. Clicking again resumes

playing;

- Stop: clicking here fades out and stops the song which is currently being played.
It will then be unloaded from memory (but not from the song list);

M Next Song: click here to start the next song in the song list. If “Shuffle” is active

(see below), a song will be randomly selected;
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[44 Back: clicking here once will restart the current song. Clicking twice or within
the first second of the song, the previous song in the song list will be started
(unless “Shuffle” is active);
Ld Fast Forward / Rewind: hold down these keys to “wind” forward or back with
4 double speed (or four times, if the option key (=3) is also held down).

The large buttons can also be activated by menu commands in the “Control” menu. This provides
the following keyboard equivalents: Press 3-. for the “Stop” button; 38-P for “Play / Pause”, 36-+
to start the “Next Song”, and 36-- (38-key and minus sign) for “Back”.

Moving to an Arbitrary Position

You can use the “Fast Forward” and “Rewind” buttons to move to a certain position in a song.
However, this might take a lot of time. With the slider between those two buttons, you can move
to any arbitrary position directly. The slider behaves like in QuickTime™ movies. Either grab the
slider with the mouse pointer and drag it to the desired position (as shown in figure 2.2), or simply

click on the desired position.

K

<+« >

Figure 2.2: Dragging the slider to move to an arbitrary position

More Control Functions

Remaining Time (38-T): here, you can choose between the display of the current playing time that
has elapsed since the beginning of the song, and the remaining playing time to the end of the song.

The remaining time is displayed as a negative number (as in figure 2.1).

Repeat (38-R): when repeat is activated, the song list will automatically be played over again,

when the last song has finished.

Shuffle: with the shuffle option activated, the songs in the song list will be played in random order

rather than sequentially.

Stereo (36-M): if your Mac has a stereo sound output, you can choose between stereo and mono.

Switching the mode might cause a short pause (or click) in the sound.

Muting: click here to suppress sound output (i.e. set the volume to zero). Unlike the “Play /

Pause” button, the song is not paused.
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3 Extended View

Sound-Trecker usually starts up with an extended view of the window. Clicking on the “zoom

box” can toggle the extended and collapsed view.

The Sound-Trecker: “space_debris” DY—————=p5|

Song List: 82 Songs (=] Band Spectrum [ Background ]
Happy Hippos.mod |+
Hopeful Towns.mod [
Jumping Jack'son.m
+ Space Debris.mod
The Sad History.mod
virgin

After Morning.mod
Amegas.M0D
Berlin.mod

] Remaining Time -03:32
[JRepeat [X] Shuffle
[ Stereo [] Muting

Play Back Options

O 44.1 @ 22 O 11kHz
(O 16 8¢ (@ 8 Bit
Fine Tuning

Pitch
Tempo

I Mixing Console 4 Yoices

W | | [ DM

¢y F. SEIDE'32

Figure 3.1: extended view of the Sound-Trecker

Die extended view contains four additional areas: the display, the mixing console, the total volume

control, and the play back options field.

3.1 The Display

With the Sound-Trecker, you cannot only listen to songs, you can also “watch” them: one of four
graphical representations of the sound signal can be shown in the display. Clicking on the E
symbol and holding down the mouse button will open a pop-up menu to choose the desired kind of
display or to switch it off, respectively. Figure 3.2 shows an example for each of the four graphical
representations.

Oscillogram: the audio signal is shown over time. The signal shown in figure 3.2a appears to be
periodic (at a period of about 70% of the display width).

Channel volumes: the volumes (signal power) of each single sound channel (voice) is shown.
Obviously, the song in figure 3.2b has four voices.
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[~] oscillogram [~] Channels

[~] Band Spectrum [~] Spectrum

Figure 3.2: the four graphical representations of the sound signal: (a) oscillogram, (b) channel volumes,

(c) equalizer-style band-spectrum, (d) real frequency spectrum

Equalizer-style band-spectrum: this is a spectrum display, which is often found on equalizers.
Each bar shows the volume (power) of a certain frequency range (or frequency band). A typical
property of audio signal can be seen in the example of figure 3.2c: the power decreases from the
basses (on the left) towards the high frequencies (right hand side).

Real frequency spectrum: the audio signal is shown over a linear frequency axis rather than over

the time axis. The longest line in figure 3.2d represents the base frequency of a tone, the long lines

to the right are the odd harmonics. The even harmonics are also present, but to a smaller extent.

3.2 The Mixing Console

With the mixing console, you can remix the voices (or sound channels) of a song. For each voice,
you can control the volume and, on Macintoshes with a stereo output, the position in the stereo
triangle individually. For example, you can listen to a single voice by turning all others off.

The mixing console can be deactivated. In that case, the volume and stereo controls are ignored.

Instead, the default settings stored with the song in the "MOD' files will be used.
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To change the stereo position, move the mouse to the corresponding stereo symbol () and
hold the mouse button down. A pop-up menu as shown in figure 3.3 will open. You can select any
stereo position between the left (L) and the right (R) speaker. The back speaker (S) denotes the
“surround” position, in which the listener has the impression of being surrounded by sound. The
surround-effect is most impressive, when the audio signal is played back on a HiFi set containing

a surround processor.

Figure 3.3: Pop-up menu to choose the stereo position. The letters denote the extreme positions left (L)

and right (R), the center position (C), and the surround-effekt (S)

3.3 Total Volume

Choose the total volume with this control. Normally, you should set the total volume to around
50% (as in figure 3.1). A greater value could lead to numerical overflow, resulting in clipping and
a significant loss of quality.

On the other hand, with a low volume, the dynamic range will not be used optimally any more,
especially if your Mac is not capable of generating 16 bit sound. Then, the noise distortions will
become unnecessarily dominant. If you choose a low total volume and turn your HiFi set up

accordingly, and you will notice an increased noise level.

34 Play Back Options

In this field, you can set the most important play back options (you will find more options in the
“Options” menu). You can also change the tempo and pitch independently.
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The background button is only available in System 7 or later. It has the same functionality as the
menu command “Background” in the “Extras” menu: to switch the Sound-Trecker into the
background to listen to "MOD' files while working on with other programs. For details, see the

description of the “Extras” menu in chapter 5.
Sampling Rate

Here you can select the output sampling rate. You can choose between 11 and 22 (Mac) and 44.1
kHz (CD) here. The same rates, as well as 32 and 48 kHz (common in digital recording facilities),
can be selected in the “Options” menu. For a detailed description of the sampling rates, see the

description of the play back options in chapter 5.
Accuracy

Here you can choose the accuracy (quantization) used when computing the audio signal. Most
current Macs only support 8 bit signals (standard Mac quality). 16 bit signals (CD quality) are
available only on Macs with 16 bit output, like “av” Macs and, hopefully, PowerPC Macs. See

also chapter 5.
Fine Tuning

You can use the two fine tuning sliders to adjust the playing tempo and pitch independently by
about £50%. Click the reset button to revert to the standard settings of the two sliders.
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4 Compiling Programs of Music

In the song list, you can compile your favorite songs to programs of music. Song lists can be
saved. Optionally, you can save the current settings like sampling rate, mon / stereo, total volume

etc. with them.

4.1 Operations in the Song List

Adding a Song to the Song List

As described in section 3.2, a song is added to the song list by selecting the “Open...” command
in the “File” menu (short cut: 38-0). The dialog box has been extended by the “Add” button, see
figure 4.1. Use “Add” instead of “Open” to add the selected song to the song list without leaving
the dialog box. This way, you can add more than one song to the song list very quickly. You can
also use the “Add” button on folders and song list files; in this case, the whole contents of the

folder or the song list file, respectively, will be added to the song list.

T3 Songs ¥ — Disk

O Chant.mod {» [ ¥ ipnd ]
D Christmas Tune -
O Complications.mod
0O Cooking it up.mod

D EDELWEIS.MOD
D FANTUOY4.MOD

0O Axel F.mod :
0O Happy Hippos.mod Iy

[ Desktop |

Figure 4.1: The dialog box extended by the “Add” button

Alternatively, you can drag and drop .MOD' files onto the Sound-Trecker icon in the Finder. With
System 7 or higher, this works even if the Sound-Trecker is already running. However, you should
avoid dragging files with a wrong file type onto the Sound-Trecker icon, especially .MOD' files,

whose file type has not been corrected, yet (see section 2.3).

The Sound-Trecker V2.0: User Manual (12/16/93) 12 Copyright © 1991-1993 by Frank Seide



4 Compiling Programs of Music

Seclecting a Song

To select a song in the song list, simply click on it. The name of the selected song will be

highlighted, as shown in figure 4.2 (the selected song is “Happy Hippos”).
Removing an Item from the Song List

To remove a song from the song list, first select it. Then press the delete key (usually labeled with
“«"). Of course, the song is not removed from the Mac's disk, only from the song list.

Changing the Sequence of Items in the Song List

To move a song in the song list to a new position, simply drag and drop it at the desired position.

While the item is being dragged, a dotted frame indicates the new position, see figure 4.2.

Enemies.mod ity
+ Happy Hippos.mod

Hopeful Towns.mod

Magnetic Fields IU.mod ::
MC Hammer.mod
Mega.mod <

Figure 4.2: Dragging a song in the song list

Duplicating an Item

If you want a song to appear more than once in the song list, you can duplicate the list entry with
the menu command “Duplicate” in the “Edit” menu (shortcut 38-D). A copy of the name will

appear just below the original entry. Now drag and drop it to the desired position.

4.2 Loading and Saving a Song List

The current song list can be saved with the menu commands “Save Song List” and “Save Song
List As...”. As usual, the file dialog box will appear. The dialog box has been extended (see
figure 4.3): you can choose, whether the current settings like sampling rate, mono / stereo, shuffle
etc. should be saved along with the song list, or not. On loading a song list, those settings will be

restored automatically.

To load a song list, use the menu command “Load Song List” @8-L). You can also use “Open...”

(38-0). In this case, the first song in the song list will be loaded and started automatically.
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i Song Lists ¥
L My favouriie Soangs [ — Disk
[ et )
[ Desktop |
&
Save the Song List as:
Songs to Relax [ Cancel ]
[] Save Current Settings Along With Song List

Figure 4.3: Extended file dialog box for saving a song list

You can also start the Sound-Trecker by double-clicking a song list file in the Finder. The Sound-
Trecker will read the song list and, if stored along with it in the file, the settings, and play the song
list, starting with the first song. Under System 7, you may place a song list (or an alias) in the
“Startup items” folder (in the System folder). This will start up the Sound-Trecker in the
background every time you boot or restart your Macintosh.

The Sound-Trecker V2.0: User Manual (12/16/93) 14 Copyright © 1991-1993 by Frank Seide



5 Other Functions

5 Other Functions

In this chapter, all functions that have not yet been covered thoroughly or not at all are described.

5.1 Detailed Description of the Play Back Options

Stereo / Surround Effects

With the stereo button, you can choose between mono and stereo sound, if your machine is
equipped with a stereo output. Alternatively, you can use the menu command “Stereo” in the
“Options” menu. The pop-up menus for selecting the stereo position can only be opened in stereo

mode.

With V2.0, the Sound-Trecker has become capable of producing surround effects. Note that, if
your HiFi set is set to mono, or if the distance between the two speakers is less than about 50 cm
(20 inches), the to stereo channels could interfere with each other, leading to undesired side
effects. That's why you can disable the generation of surround effects with the menu option
“Surround Effects”.

Sound Filter

When playing back "MOD' files using a HiFi set, you might notice some distortions. The Sound-
Trecker can filter those distortions out. Use the menu option “Realtime Sound Filter” to switch

the filter on and off. The realtime filter can be toggled at any time, and takes effect immediately.

However, with the realtime filter on, sound generation requires about three times the CPU time.
On fast Macs, like the Quadra’s, you will hardly notice this additional computation time.
However, on the slower machines, like the Mac LC, the performance might decrease significantly.
To avoid this, you can perform a limited pre-filtering at load time, which doubles the memory
required by the song. In most cases, the realtime filter can be omitted. Use the menu option “Pre-
Filter at Load Time” to toggle the pre-filter. Since filtering is performed at load time, changing

this option will take effect when the next song is loaded and started.
Sampling Rates

When digitizing a sound, it will be sampled at a certain rate, the sampling rate or sampling
frequency. The chosen sampling rate determines the highest frequency component contained in the
audio signal: it is identical to the half of the sampling frequency (in digital signal processing
theory, this relation is called the sampling theorem or the Nyquist theorem). At a sampling rate of

11 kHz, the maximal frequency component is 5.5 kHz (a little more than on a standard phone
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line), while at 44.1 kHz, the frequencies up to 22 kHz are possible (the human ear is only sensitive
up to about 20 kHz).

The required computation time is ‘“proportional” to the sampling rate. For example, playing back
at 22 kHz requires twice the CPU time than at 11 kHz. The optimal choice of the sampling rate
depends on your Macintosh's speed and the quality of your HiFi set (if used). Please note, that
sampling rates above 22 kHz can only by played back on Macintoshes equipped with a Digital
Signal Processor (DSP), currently only on the Macs of the “av” series, and, hopefully, on the
PowerPC Macs. The following list is intended to aid you in choosing a sampling rate suitable to

your needs.

11 kHz: this is the lowest sampling rate possible. It requires the least CPU time, but the sound
quality is only a little better than telephony. Usually, 11 kHz is suitable if you play back your
"MQOD' files using the built-in speaker.

22 kHz: this is the standard sampling rate of the Macintosh and the highest one you can use on
Macintosh models without a Digital Signal Processor (DSP). You should use 22 kHz when
playing back over a HiFi set. The quality is slightly less than standard FM radio.

32 kHz: this sampling rate is common in professional digital recording studios and is also used
for digital satellite radio (DSR). The quality is comparable with standard FM radio. For "MOD'
files composed on Commodore-Amiga computers, this is the optimal sampling rate, because the
maximum sampling rate available on the Amiga is about 32 kHz. Note, that Macintosh models
without a Digital Signal Processor cannot use this sampling rate; use 22 kHz instead.

44.1 kHz: this sampling rate is used by every CD player and by Philips' digital compact cassette
(DCC). The rate was chosen to be just high enough to provide all frequencies that the human ear
can hear. However, most "MOD' files do not contain such high frequency components. When
playing back in 8 bit mode, selecting 44.1 kHz could result in expanding the unavoidable noise
distortion to a larger frequency range, without really improving the sound quality. On some
"MOD' files, the improvement is noticeable. For 44.1 kHz, your Macintosh requires a Digital
Signal Processor (DSP).

48 kHz: this is the standard rate for the digital audio tape (DAT). The remarks for 44.1 kHz also
apply here.

Accuracy

On standard Macs, the Sound-Trecker produces digital audio data at a precision of 8 Bit. Each
sample value must be represented by only 8 bits. This inaccuracy leads to an audible “hiss” called
“quantization noise”. The intensity of those noise distortions is comparable with that found on a
standard, analog compact cassette. Since the Macintosh models without a Digital Signal Processor
are not capable of handling audio data with more than 8 bits, the noise distortions are unavoidable

on those machines.
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At a precision of at least 16 bits, the inaccuracy is no more noticeable to the human ear. That's
why, on a CD music is stored at a precision of 16 bits. The hardware required for playing back 16
bit samples has been built into all Macintosh models equipped with a Digital Signal Processor
(DSP), and, hopefully, on the PowerPC Macs. On those machines, 16 bit mode is set by default.

5.2 Control Options

The order in which songs are played can be controlled with the following commands in the

“Control” menu: “Repeat”, “Shuffle”, and “Loop-Suppression”.

Repeat: if active, the whole song list will be played over again, when the last song of the song list
has finished.

Shuffle: if active, the songs in the song list will be played in a random order rather than
sequentially.

Loop-Suppression: for some "MOD' files, the end point has not been defined. They run into an
endless loop, which repeats the same bars over and over again. If loop-suppression is activated,
any song falling into an endless loop will be faded out and stopped immediately. Then, the Sound-

Trecker will continue with the next song.

5.3 Saving the Settings

You can save the current settings (sampling rate, total volume, mixing console settings etc.) as
your default settings with the menu command “Save Default Settings” of the “Extras” menu. The
settings will be saved in the file “Sound-Trecker-Settings” in the standard “Preferences” folder of

System 7, which is located in the System folder.
Every time the Sound-Trecker is started, it reads and restores these default settings. In case you

have modified some options, you can restore your default settings at any time with the menu

command “Default Settings”.

5.4 Special Functions

In this section, four special menu commands are to be described, which have not been mentioned,

yet, because they did not really fit into any of the sections above.
Record to File... (“File” menu): with this menu command, you can “record” a "MOD' song to a

standard audio file, either as an 'AIFF' file or a standard System 7 sound. The 'AIFF' format is
Apple's standard interchange format for audio data; 'AIFF' files can be read by any of the major
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sound or multimedia programs. System 7 sounds can be listened to directly from within the Finder

by just double-clicking on them, of they are not too long.

i Export ¥
4 = Disk
[ #pet )
[ Desktop |
]
Export as Audio File:
Song.audio [ cancel |
Mode: {) Stereo (® Mono
File Format: ) AIFF @ System 7 Sound
Frequency: {48 (O 44O 32 @ 22 () 11kHz
Accuracy: (O i6 Bit (@ 8 Bit
Filter: O best () normal @ off
Compression: {® none {0 3:1 {0 6:1
Mixing: {) Default ® Use Console

Figure 5.1: Extended file dialog box for recording a ."MOD' to an audio file

After selecting “Record to File...”, the extended file dialog box shown in figure 5.1 will appear.
Here, you can change all audio-settings for the file to be recorded, independent of the normal
settings that the Sound-Trecker uses for normal play back. Please note, that an audio file usually
requires a lot of disk space. Recording at 22 kHz in stereo requires 44 kByte per second, which is

more than 2.6 MByte per minute!

Information... (“Edit” menu): use this command to obtain information about the selected song in

the song list. Figure 5.2 shows a typical information window.
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Title:
File format:

Time:
Yoices:

Author :
Arranged by :
Copyright:

Comment :

Instruments:

s=t-01:nice
=t-01:=ynbra
=t-01: popsna
=t-01:bas=dr
=t-01:d=tom
=t-01:hihatz
=t-01:=oundt
=t-01:blast
hal lbr

Information about:
Axel F.mod
axel.f
Arniga MoiseTracker
1027 Positions: 23 BFH: 125
4 Patterns: 33 Key : n'a
nea
nta
nta
nta
15
g Instrument No. 11
== H]
el ;i Length: e Bytes
umz2 . Loop from to
Yolume : 4E 5% (-5 dB)
Position: -
rack

Figure 5.2: Information window

Speed Measurement (“Extras” menu): this command determines, how much processing time is

currently used for sound generation. The result is expressed as a percentage.

Background (“Extras” menu): closes the Sound-Trecker window and activates one of the other

open applications (for example, the Finder). The music will now be generated in the background,

while you can work on with another application.

This function requires the multitasking capabilities of System 7, it is not available under system

6.0.7. Under system 6.0.7 you can send the Sound-Trecker to the background by clicking into a

window of another application (or the Finder) while holding down the option key (=:3). The music

will be played on.
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Appendix A: Transferring '.MOD’ files to Your Mac

"MOD' files are widely available for the Macintosh. Those times, when you had to transfer every
"MOD' file from other computer worlds to the Mac, are fortunately over. Now you can get ."MOD'
files in any major collection of public-domain software, at Macintosh clubs, in Mac Bulletin

Board Systems, and certainly from other Macintosh users.

The following hints are intended for those occasions when you want to get "MOD' files from non-

Macintosh Bulletin Boards or from other computer worlds.

A.1 Bulletin Boards

Many Bulletin Board Systems (BBSs) for the Macintosh already have sections for "MOD' files. In
non-Mac-BBSs, "MOD' files are often found in the Amiga section (if present). Many BBSs also
have special "MOD' file sections. After downloading and, if necessary, unpacking, '"MOD' files

can be played directly on the Macintosh by the Sound-Trecker.

A.2  Transferring from PC Disks

If the "MOD' file is stored on an accessible alien computer, the easiest way of transferring is to
copy the file to a 3.5" MS-DOS-formatted diskette (720 kByte oder 1.4 MByte). These diskettes
are used by all PC/AT compatibles as well as by Atari ST/TT computers; special conversion

programs are not necessary.

The Amiga's native diskette format is different. However, part of the newer versions of the Amiga
Workbench is a special filing-system for reading and writing MS-DOS disks. You could also use

the commercial program “Dos-2-Dos” or the filing-systems “Cross-Dos” and “MSH” (shareware).

Once the "MOD' file is available on a 3.5" MS-DOS diskette, the Macintosh can read it. A file
conversion program to read DOS disks called “Apple File Exchange” is part of your system
software. Alternatively, you can use the system extensions “AccessPC” by Insignia Solutions or
Apple's “Macintosh PC Exchange”.

A3 Altering the File Type

As opposed to the Macintosh, most other operating systems have no way of marking a file as a
"MOD' file. That's why the file types TEXT" or '????" are by default assigned to newly transferred
"MOD' files. You should not try to start such a "MOD' file by double-clicking on it in the Finder,
because TeachText will try to display the "MOD' file as ASCII text. However, "MOD' files do not
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contain ASCII text. Instead, you should start the Sound-Trecker and open the song using the menu
command “Open...” from the “File” menu, as described in chapter 2. The file type and the file's

icon will then be altered automatically.
If you use “AccessPC” to read ."MOD' files from a DOS disk, you can define an automatic type

conversion in the “AccessPC” control panel. You just have to specify the MS-DOS extension
“.MOD” and assign it the file type 'STrk' of the application “The Sound-Trecker V2.0”.
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Appendix B: Technical Details

In this appendix, the basics of the "MOD' file format are described, and how the Sound-Trecker
works in principal. Those of you who want to use the Sound-Trecker's playing capabilities from
within your own programs and presentations might want to refer to “The Sound-Trecker V2.0:
Programmer's Guide” and to “The Sound-Trecker V2.0: 'XFCN' Manual”.

B.1 What are '.MOD' files ?!?

"MOD' files do not contain simply digitized music. This would waste too much space on your
hard disk. At a sampling rate of 22 kHz, digitizing sound directly would require 22 KByte per
second, about 1.3 MByte per minute! Current compression schemes for reducing the immense

amount of data usually can't “compress away” more than 50%.

When the Sound-Trecker plays a "MOD' file, one half of the software can be imagined as a
simulator of a polyphonic synthesizer, which is “played” by the other half of the software it. Thus,
"MOD' files contain two different kinds of data:

 data for the simulation of a synthesizer. These data are basically the digitized sounds of real
instruments. Only one tone per instrument is stored, which can played back at different
pitches (in the new extended "MOD' file format introduced by the Sound-Trecker V2.0,
multi-sample instruments will be possible;

 the “notes” that are used to play the synthesizer. Compared to the instrument data, the note
data use up only a small portion of the file. That's why even long songs are often shorter

than 100 KByte, as long as they don't use too many instruments.

B.2 Mixing the Sound Channels

The Sound-Trecker simulates a polyphonic synthesizer, i.e. it mixes digitized sound at different
pitches and volumes together and sends them to the speaker and the headphone jack. A part of the
system software, the “Sound Manager” of system 7 (also contained in system 6.0.7), can perform
the same operation. Unfortunately, Apples Sound Manager requires that much processing time,
that a Mac LC cannot play more than three channels at the same time. Music in "MOD' files

usually has four channels (the new version 3.0 of the Sound Manager, is a little faster now).

Since each sound channel managed by the Sound Manager eats up unnecessarily much CPU time,
the Sound-Trecker uses only one sound channel from the operating system with a constant
sampling rate (which may be chosen between 11 and 48 kHz by the user). The Sound-Trecker

does all the mixing itself and creates one common data stream. This completely prepared data
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stream is then handed over to the operating system. By using hand-optimized M680x0 assembly
language, the processing time was reduced to approximately one third of the original. With the

Sound-Trecker Sound System, even a Mac LC can play back up to 12 voices at the same time.

B.3 Sampling Rate Conversion

Simulating a synthesizer is basically a simple task: first, capture the sound of the desired
instrument by digitizing one tone at a certain pitch. To play the instrument at a different pitch, the
sampled tone is simply played back at a different speed. Everyone has experienced this effect
when playing an LP to be played at 33 rpm at 45 rpm instead. In digital signal processing,
changing the speed means changing the sampling rate: sampling rate conversion. This process

requires the most CPU time in the Sound-Trecker.

An example. Assume we have digitized a “C” from a piano at a sampling rate of 11 kHz. Now, if
we want to play a piano “D”, the digitized “C” is to be played back at a slightly higher sampling
rate, just like a tape recorder running a little to fast. The sampling rate has to be increased by 21/12
per semitone, which is about 5.946%. “D” is two semitones higher than “C”, so the output
sampling rate has to be approximately 11 kHz « 1.05946 « 1.05946 = 12.347 kHz.

So, how do we play back a sample at 12.347 Hz, although the Sound-Trecker generates its output
using a fixed sampling rate (e.g. 22 kHz), instead of the desired 12.347 kHz? The problem is that
we have sample values at every 12347th of a second, but we need sample values at every 22000th
of a second. Thus, we need sample values at times for which we don't have sample values for.

How do we get them?

A simple way of “estimating” the unknown sample values from the known ones is to use the
closest one known (the “nearest neighbor”). This scheme is very quick, but it produces distortions
that may be apparent with some instruments (because the “sampling theorem” mentioned in

section 5.1 is violated). These distortions are called “aliasing distortions”.

To improve output quality, the aliasing distortions must be filtered out. The filter can be switched
on with the menu option “Realtime Sound Filter” in the “Options” menu. Then, the unknown
sample values are computed by linear interpolation from the left and right neighbor. The
distortions are reduced significantly, although they don't disappear entirely. For this, the filter

algorithm would be too complex to be performed on the current M680x0 Macs in realtime.

The new Macintosh models of the “av” series are equipped with a Digital Signal Processor (DSP),
which are perfect for this filtering task. Future versions of the Sound-Trecker may use the DSP
directly to significantly improve sound quality. Furthermore, the new PowerPC Macintoshes

might be fast enough for the filtering.
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